Model created in COMSOL Multiphysics 6.4

Solid Oxide Electrolyzer

This model is licensed under the COMSOL Software License Agreement 6.4.
All trademarks are the property of their respective owners. See www.comsol.com/trademarks.



http://www.comsol.com/sla
http://www.comsol.com/trademarks/

Introduction

This example models a solid oxide electrolyzer cell wherein water vapor is reduced to form
hydrogen gas on the cathode, and oxygen gas is evolved on the anode. The current
distribution in the cell is coupled to the cathode mass transfer of hydrogen and water and
momentum transport.

Model Definition

On the anode, oxygen ions are oxidized to form oxygen gas,
207 & Oy(g) +4e’ (1
whereas on the cathode, water vapor is reduced to form hydrogen gas and oxygen ions:
2H,0(g) + 4 > 2Hy(g)+20° )

Figure 1 shows the model geometry. Since the oxygen is the only gas present in the anode
gas chamber, and isobaric conditions are assumed, there is no need to explicitly model the

anode gas transport. Four computational domains are hence used in the model: the
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cathode gas channels, the cathode gas diffusion electrode, the solid oxide electrolyte layer,

and the anode gas diffusion electrode.

Inlet

Outlet

Figure 1: Model geometry. From top: Cathode gas channels, cathode gas diffusion electrode,
solid oxide electrolyte layer, and anode gas diffusion layer. The positions of the inlet and outlet
arve indicated in the figure.

The composition of the hydrogen-water vapor mixture will change as a result of the
electrochemical reactions. The mass transport of hydrogen and water vapor is modeled in
the cathode gas channels and the gas diffusion electrode, coupled to the resulting
(laminar) flow of the gas mixture.

The current distribution is defined assuming a constant conductivity of the solid
electrolyte. The Water Electrolyzer interface is used to define the electrode reactions and
the electrolyte charge transport in the porous gas diffusion electrodes and the electrolyte
layer, as well as the mass transport of hydrogen and water. The momentum flow is defined
in the model using the Free and Porous Media Flow, Brinkman interface. Brinkman
equations are used for the porous gas diffusion electrodes and Navier-Stokes equations are
used for the nonporous gas channels.

On the cathode side, the electrode kinetics depends on the local concentration of water
and hydrogen according to the law of mass action (and Nernst equation). On the anode
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side, and a uniform partial pressure of oxygen is assumed and a concentration-independent

Butler-Volmer expression is hence used to define the electrode kinetics.

The properties of the cathode gas mixture, as well as the equilibrium potentials of the
electrode reactions are automatically defined by the default built-in options of the Water

Electrolyzer interface.

Results and Discussion

Figure 2 shows the velocity magnitude distribution in the cell. The highest velocities are

located close to the inlet and outlet.

1_avg(10)=10000 A/m? Multislice: Velocity magnitude (m/s) Streamline: Velocity field

Figure 2: Velocity in the cell.
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Figure 3 shows how the density and the dynamic viscosity of the gas relate to the hydrogen
and water molar fractions shown in Figure 4. As the hydrogen content of the gas increases
toward the outlet, the density and the viscosity both decrease.

1_avg(10)=10000 A/m?  Density (kg/m’) |_avg(10)=10000 A/m’ Dynamic viscosity (Pa*s)
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Figure 3: Density (left) and dynamic viscosity (vight).
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Figure 4: Hydrogen (left) and water vapor (vight) molar fractions.
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Figure 5 shows the molar fraction of hydrogen in the gas mixture, and the corresponding
hydrogen flux streamlines. The molar fraction is close to zero at the inlet and surpasses 90%
at the outlet.

1_avg(10)=10000 A/m? Streamline: Total flux Volume: Mole fraction (1)

Figure 5: Hydrogen molar fraction (slice) and flux (streamlines).

Finally, Figure 6 shows the cross-sectional electrolyte current density in the middle of the
electrolyte between the anode and the cathode. The current density is highest close to the

inlet, where the water,/hydrogen ratio is high, and decreases toward the outlet.
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1_avg(10)=10000 A/m? Electrolyte current density vector, z-component (A/m?)
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Figure 6: Electrolyte current density through electrolyte layer.

Finally, Figure 7 shows the cell voltage as a function of the average current density

(polarization curve).
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Polarization plot
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Figure 7: Polarization curve.

Application Library path: Fuel_Cell_and_Electrolyzer_Module/Electrolyzers/
soec

Modeling Instructions

This tutorial models the current distribution in a solid oxide electrolyzer. The tutorial
comprises two major parts. First, a secondary (not concentration dependent) current
distribution is modeled. In the second part, mass and momentum transport are added to
model a concentration-dependent current distribution of the cell, where the mixture

properties of the anode gas depends on the mole fractions of water and hydrogen.

From the File menu, choose New.

NEW
In the New window, click Model Wizard.
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MODEL WIZARD

I In the Model Wizard window, click [l 3D.
2 In the Select Physics tree, select Electrochemistry > Water Electrolyzers > Solid Oxide (we).
3 Click Add.

4 Click e Study.

5 In the Select Study tree, sclect Preset Studies for Selected Physics Interfaces >

Stationary with Initialization.

6 Click [/ Done.

GEOMETRY |

The model geometry is available as a parameterized geometry sequence in a separate MPH
file. If you want to build it from scratch, follow the instructions in the section Appendix -
Geometry Modeling Instructions. Otherwise load it from file using the following steps.

I In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file
soec_geom_sequence.mph.

3 In the Geometry toolbar, click [E Build All.

4 In the Model Builder window, under Component | (compl) click Geometry 1.
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GLOBAL DEFINITIONS

Geometry Parameters
I In the Model Builder window, under Global Definitions click Parameters 1I.

2 In the Settings window for Parameters, typc Geometry Parameters in the Label text
field.

Physics Parameters

Some parameters were imported with the geometry sequence. Import some additional
physics parameters from a text file.

I In the Home toolbar, click Pi Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Physics Parameters in the Label text
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
soec_physics_parameters.txt.

DEFINITIONS

Add an average operator which will be used later while plotting the polarization plot.
Average | (aveopl)

I In the Definitions toolbar, click {//// Nonlocal Couplings and choose Average.

2 In the Settings window for Average, type aveop_an in the Operator name text field.

3 Locate the Source Selection scction. From the Geometric entity level list, choose

Boundary.

4 From the Selection list, choosec Anode Current Collector.

WATER ELECTROLYZER (WE)

Now define the current distribution in the gas diffusion electrodes and the electrolyte.

I In the Model Builder window, under Component | (compl) click Water Electrolyzer (we).
In the Settings window for Water Electrolyzer, locate the Domain Selection section.
Click 1‘ Clear Selection.

2
3
4 Select Domains 1-3 only.
5

Locate the H2 Gas Mixture section. Find the Transport mechanisms subsection. Clear the
Include gas phase diffusion checkbox.
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Membrane |

I In the Physics toolbar, click [ Domains and choose Membrane.

2 Select Domain 2 only.

ADD MATERIAL

I In the Materials toolbar, click #.7 Add Material to open the Add Material window.
2 Go to the Add Material window.

3 In the tree, select Fuel Cell and Electrolyzer > Solid Oxides > Yttria-Stabilized Zirconia,
8YSZ, (Zr02)0.92-(Y203)0.08.

4 Right-click and choose Add to Component | (compl).

5 In the Materials toolbar, click 35 Add Material to close the Add Material window.

WATER ELECTROLYZER (WE)

Electrolyte Phase |
In the Electrolyte Phase node, the electrolyte conductivity is set to be taken from the

Materials node.

H2 Gas Diffusion Electrode |

Set up the properties of the H2 Gas Diffusion Electrode node. The details of electrode
kinetics are set in the child node. Note that the reference equilibrium potential is
calculated automatically when the default Built in option is used.

I In the Physics toolbar, click {8 Demains and choose H2 Gas Diffusion Electrode.

2 In the Settings window for H2 Gas Diffusion Electrode, locate the Domain Selection

section.
3 From the Selection list, choose Cathode.
4 Locate the Electrode Charge Transport section. In the o text field, type sigmaeff_s.
5 Locate the Effective Electrolyte Charge Transport scction. In the g text field, type por_1.
H2 Gas Diffusion Electrode Reaction |
I In the Model Builder window, click H2 Gas Diffusion Electrode Reaction I.

2 In the Settings window for H2 Gas Diffusion Electrode Reaction, locate the

Electrode Kinetics section.
3 In the i (7T text field, type 10_H2.

4 Locate the Active Specific Surface Area section. In the a, text field, type S.
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02 Gas Diffusion Electrode |

Similarly, set up the properties of the 02 Gas Diffusion Electrode node. The details of
electrode kinetics are set in the child node. Note that the reference equilibrium potential
is calculated automatically when the default Built in option is used.

I In the Physics toolbar, click {#¥ Domains and choose 02 Gas Diffusion Electrode.

2 In the Settings window for 02 Gas Diffusion Electrode, locate the Domain Selection

section.
3 From the Selection list, choose Anode.
4 Locate the Electrode Charge Transport section. In the o text field, type sigmaeff_s.
5 Locate the Effective Electrolyte Charge Transport section. In the g text field, type por_1.
02 Gas Diffusion Electrode Reaction |
I In the Model Builder window, click 02 Gas Diffusion Electrode Reaction I.

2 In the Settings window for 02 Gas Diffusion Electrode Reaction, locate the

Electrode Kinetics section.
3 In the ig fT) text field, type 10_02.
4 Locate the Active Specific Surface Area section. In the a, text field, type S.

Electronic Conducting Phase |
Finally, set up the boundary conditions.

I In the Model Builder window, under Component | (compl) > Water Electrolyzer (we)

click Electronic Conducting Phase |.
Electric Ground |
I In the Physics toolbar, click |=° Attributes and choose Electric Ground.
2 In the Settings window for Electric Ground, locate the Boundary Selection section.
3 From the Selection list, choose Cathode Current Collector.
4 Locate the Contact Resistance section. Select the Include contact resistance checkbox.
5 In the R, text field, type Rc.

Electronic Conducting Phase |
In the Model Builder window, click Electronic Conducting Phase 1.

Electrode Current |
I In the Physics toolbar, click |=° Attributes and choose Electrode Current.

2 In the Settings window for Electrode Current, locate the Electrode Current section.

3 From the list, choose Average current density.
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4 Locate the Boundary Selection scction. From the Selection list, choose

Anode Current Collector.
5 Locate the Electrode Current scction. In the ig gyerage text ficld, type I_avg.
6 Locate the Contact Resistance section. Select the Include contact resistance checkbox.

7 In the R, text field, type Rc.

GLOBAL DEFINITIONS

Default Model Inputs

Default Model Inputs node can be used to set the Temperature for the entire model. This
node may be accessed by multiple physics nodes.

I In the Model Builder window, under Global Definitions click Default Model Inputs.

2 In the Settings window for Default Model Inputs, locate the Browse Model Inputs section.
3 In the tree, select General > Temperature (K) - minput.T.

4 Find the Expression for remaining selection subsection. In the Temperature text ficld,
type T.

MESH 1

The physics settings for the first part of the tutorial are now complete. Add a user-defined

mesh.

Size |
I In the Model Builder window, under Component | (compl) right-click Mesh 1 and choose

Size.
2 In the Settings window for Size, click to expand the Element Size Parameters section.
3 Locate the Element Size section. Click the Custom button.
4 Locate the Element Size Parameters scction.
5 Select the Maximum element size checkbox. In the associated text field, type H_ch*0.8.

Swept |
I In the Mesh toolbar, click 4

. Swept.
2 In the Settings window for Swept, locate the Domain Selection section.
3 From the Geometric entity level list, choose Domain.

4 Select Domains 5-7 only.
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5 Click ™ Build Selected.

x10™

Free Tetrahedral |
I In the Mesh toolbar, click & Free Tetrahedral.

2 In the Settings window for Free Tetrahedral, locate the Domain Selection section.
3 From the Geometric entity level list, choosec Domain.

4 Seclect Domains 4 and 8 only.
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5 Click ™ Build Selected.

Boundary Layers |
Also a boundary layer mesh at this stage. These are actually not needed for the first
calculation, but will improve the accuracy and convergence of the solution for the second

part of the tutorial when mass transport and convection has been added.

I In the Mesh toolbar, click Boundary Layers.

2 In the Settings window for Boundary Layers, locate the Geometric Entity Selection

section.
3 From the Geometric entity level list, choose Domain.
4 From the Selection list, choose Channel Domains.
Boundary Layer Properties
I In the Model Builder window, click Boundary Layer Properties.

2 In the Settings window for Boundary Layer Properties, locate the Boundary Selection

section.
3 From the Selection list, choose Boundary Layer Boundaries.
4 Locate the Layers section. In the Number of layers text field, type 2.

5 In the Stretching factor text field, type 1.3.
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6 From the Thickness specification list, choose First layer.

7 In the Thickness text field, type H_ch/10.

8 Click ™ Build Selected.

Free Triangular |

I In the Mesh toolbar, click A More Generators and choose Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.
3 From the Selection list, choose Cathode Current Collector.

4 Click ™ Build Selected.

Swept 2
In the Mesh toolbar, click 22, Swept.

Distribution |
I Right-click Swept 2 and choose Distribution.
2 In the Settings window for Distribution, locate the Domain Selection section.

3 Click | Clear Selection.

4 Seclect Domain 3 only.

5 Locate the Distribution section. From the Distribution type list, choose Predefined.

16 | SOLID OXIDE ELECTROLYZER



6 In the Element ratio text field, type 2.

7 Sclect the Reverse direction checkbox.

Distribution 2

I In the Model Builder window, right-click Swept 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Domain Selection section.

Clear Selection.

4 Seclect Domain 2 only.

5 Locate the Distribution section. In the Number of elements text field, type 2.

Distribution 3
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4 Seclect Domain 1 only.

5 Locate the Distribution section. Clear the Reverse direction checkbox.

6 Click [E§ Build All.
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STUDY |

The problem is now ready for solving.
I In the Study toolbar, click = Compute.
RESULTS

Electrode Potential with Respect to Ground (we)
I In the Electrode Potential with Respect to Ground (we) toolbar, click Plot.

Inspect the potential plot. The plot should look as follows:

Multislice: Electric potential (V) Arrow Volume: Electrode current density vector

0.8

0.4

0.2

COMPONENT I (COMPI)

Now start with the second part of the tutorial which adds a Free and Porous Media Flow
interface to the cathode side of the model, enables hydrogen gas phase diffusion in the
Water Electrolyzer interface, and couples the distribution of hydrogen and water vapor to
the electrochemistry.

ADD PHYSICS
I In the Home toolbar, click i Add Physics to open the Add Physics window.

2 Go to the Add Physics window.
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3 In the tree, select Fluid Flow > Porous Media and Subsurface Flow >

Free and Porous Media Flow, Brinkman (fp).
4 Click the Add to Component | button in the window toolbar.

5 In the Home toolbar, click L Add Physics to close the Add Physics window.

FREE AND POROUS MEDIA FLOW, BRINKMAN (FP)
I Select Domains 3-8 only.

2 In the Settings window for Free and Porous Media Flow, Brinkman, locate the

Domain Selection section.

Click T Create Selection.

In the Create Selection dialog, type Gas domains in the Selection name text field.
Click OK.

o U1 A W

In the Settings window for Free and Porous Media Flow, Brinkman, locate the

Physical Model section.
7 From the Compressibility list, choose Compressible flow (Ma<0.3).
Porous Medium |
I In the Physics toolbar, click IB= Domains and choose Porous Medium.
2 In the Settings window for Porous Medium, locate the Domain Selection section.
3 From the Selection list, choose Cathode.
Porous Matrix |
I In the Model Builder window, click Porous Matrix 1.
2 In the Settings window for Porous Matrix, locate the Matrix Properties section.
3 From the g list, choose User defined. In the associated text field, type por.
4 From the « list, choose User defined. In the associated text field, type kappa.
Inlet |
I In the Physics toolbar, click mw Boundaries and choose Inlet.
2 In the Settings window for Inlet, locate the Boundary Selection section.
3 From the Selection list, choose Inlet.
4 Locate the Boundary Condition section. From the list, choose Mass flow.
5 Locate the Mass Flow section. In the m text field, type we.h2gasph1.h2in1.J0.

Outlet |
I In the Physics toolbar, click mw Boundaries and choose Outlet.
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2 In the Settings window for Outlet, locate the Boundary Selection section.
3 From the Selection list, choose Outlet.

4 ILocate the Pressure Conditions section. Select the Normal flow checkbox.

MULTIPHYSICS

Reacting Flow, H2 Gas Phase | (rfhl)
In the Physics toolbar, click ﬁga\u Multiphysics Couplings and choose Domain > Reacting Flow,
H2 Gas Phase.

WATER ELECTROLYZER (WE)

I In the Model Builder window, under Component | (compl) click Water Electrolyzer (we).

2 In the Settings window for Water Electrolyzer, locate the Domain Selection section.

3 From the Selection list, choose All domains.

4 Locate the H2 Gas Mixture scction. Find the Transport mechanisms subsection. Select the
Include gas phase diffusion checkbox.

H2 Gas Flow Channel |

I In the Physics toolbar, click {#8 Domains and choose H2 Gas Flow Channel.

2 In the Settings window for H2 Gas Flow Channel, locate the Domain Selection section.

3 From the Selection list, choose Channel Domains.

H2 Gas Diffusion Electrode |

I In the Model Builder window, click H2 Gas Diffusion Electrode 1.

2 In the Settings window for H2 Gas Diffusion Electrode, locate the Gas Transport section.

3 In the &, text field, type por.

4 Select the Include pore-wall interaction checkbox.

5 In the dpgpe text field, type d_pore.

H2 Gas Phase |

Note that the settings on the H2 Gas Phase node are either the default option or

automatically set by the multiphysics coupling node. Set up the required boundary
conditions and initial values.

I In the Model Builder window, click H2 Gas Phase I.

H2 Inlet |
I In the Physics toolbar, click |=° Attributes and choose H2 Inlet.

2 In the Settings window for H2 Inlet, locate the Boundary Selection section.
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3 From the Selection list, choose Inlet.
4 Locate the Stoichiometric Feed scction. In the I text field, type I_avg_max*A_cell.
5 In the Syoq text field, type stoich.

H2 Gas Phase |
In the Model Builder window, click H2 Gas Phase 1.

H2 Outlet |
I In the Physics toolbar, click |=° Attributes and choose H2 Outlet.

2 In the Settings window for H2 Outlet, locate the Boundary Selection section.

3 From the Selection list, choose Outlet.

Initial Values |

I In the Model Builder window, click Initial Values 1.

2 In the Settings window for Initial Values, locate the Initial Composition section.

3 In the xq oo text field, type 0.99.

STUDY |

The concentration-dependent model is now ready for solving. Use a sequence of study
steps, solving first for the current distribution initialization, then the flow, and finally the
fully coupled problem. By solving for only one set of physics at a time in individual steps,
suitable initial values automatically propagate to the final study step where the complete

problem is solved.

Step [: Current Distribution Initialization
I In the Model Builder window, under Study 1 click

Step I: Current Distribution Initialization.

2 In the Settings window for Current Distribution Initialization, locate the

Physics and Variables Selection section.

3 In the Solve for column of the table, under Component | (compl) > Multiphysics, clear
the checkbox for Reacting Flow, H2 Gas Phase | (rfhl).

Step 2: Stationary

I In the Model Builder window, click Step 2: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection scction.

3 In the Solve for column of the table, under Component | (compl), clear the checkbox for

Water Electrolyzer (we).
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4 In the Solve for column of the table, under Component | (compl) > Multiphysics, clear
the checkbox for Reacting Flow, H2 Gas Phase | (rfhl).

Step 3: Stationary 2

I In the Study toolbar, click E Stationary.

Use Auxiliary sweep to generate the polarization plot.

In the Settings window for Stationary, click to expand the Study Extensions section.

Select the Auxiliary sweep checkbox.

Click + Add.

Vi A W N

In the table, enter the following settings:

Parameter name Parameter value list Parameter unit

|_avg (Average current density) I_avg_max*range(0.1,0.1, A/m"2
1)

Solver Configurations
Remove the old study sequence and generate a new one.

In the Model Builder window, under Study I right-click Solver Configurations and choose

Delete Configurations.

Solution [ (soll)

I In the Study toolbar, click M= Show Default Solver.

2 In the Model Builder window, expand the Solution I (soll) node.

3 In the Model Builder window, expand the Study | > Solver Configurations >

Solution | (soll) > Stationary Solver 3 node.
4 Right-click Stationary Solver 3 and choose Fully Coupled.
5 In the Study toolbar, click = Compute.

The problem should solve in about two minutes.

RESULTS
Start the postprocessing of the solution by inspecting and polishing the default plot for the
velocity field.

Multislice |
I In the Model Builder window, expand the Results > Velocity (fp) node, then click
Multislice I.

2 In the Settings window for Multislice, locate the Multiplane Data section.
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3 Find the x-planes subsection. In the Planes text field, type 0.

4 Find the y-planes subsection. In the Planes text field, type 0.

5 Find the z-planes subsection. From the Entry method list, choose Coordinates.
6 In the Coordinates text field, type H_cell-H_ch/2.

7 In the Velocity (fp) toolbar, click Plot.

Streamline |

I In the Model Builder window, right-click Velocity (fp) and choose Streamline.

2 In the Settings window for Streamline, click Replace Expression in the upper-right corner
of the Expression section. From the menu, choose Component | (compl) >

Free and Porous Media Flow, Brinkman > Velocity and pressure > u,v,w - Velocity field.
3 Locate the Selection section. From the Selection list, choose Inlet.

4 Locate the Coloring and Style section. Find the Point style subsection. From the Type list,

choose Arrow.
5 From the Arrow distribution list, choose Equal inverse time.
6 From the Color list, choose Black.

7 In the Velocity (fp) toolbar, click Plot.

1_avg(10)=10000 A/m? Multislice: Velocity magnitude (m/s) Streamline: Velocity field
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Density
The density of the gas mixture will change as water is replaced by hydrogen in the gas
stream. Plot the density as follows:

I In the Results toolbar, click .‘i 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Density in the Label text field.
Surface |

I Right-click Density and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of
the Expression section. From the menu, choose Component | (compl) >

Free and Porous Media Flow, Brinkman > Material properties > fp.rho - Density - kg/m?.

3 In the Density toolbar, click Plot.

1_avg(10)=10000 A/m’ Density (kg/m”)
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Viscosity

Also, the viscosity will change in the gas stream.

I In the Results toolbar, click .‘i 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Viscosity in the Label text field.
Surface |

I Right-click Viscosity and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of
the Expression section. From the menu, choose Component | (compl) >
Free and Porous Media Flow, Brinkman > Material properties > fp.mu - Dynamic viscosity -
Pa-s.
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3 In the Viscosity toolbar, click Plot.

|_avg(10)=10000 A/m” Dynamic viscosity (Pa*s)

x107°

Mole Fraction, H2, Surface (we)

Default plots are created for the hydrogen and water mole fractions.

Surface |

I In the Model Builder window, expand the Mole Fraction, H2, Surface (we) node, then click
Surface |.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Color table list, choose ConopiformisZero.
1_avg(10)=10000 A/m? Species H2: Mole fraction (1)
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Surface |

I In the Model Builder window, expand the Mole Fraction, H20, Surface (we) node, then
click Surface I.

2 In the Settings window for Surface, locate the Coloring and Style section.
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3 From the Color table list, choose Prionace.

|_avg(10)=10000 A/m’ Species H20: Mole fraction (1)
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Mole Fraction and Flux, H2
Create a plot for the hydrogen mole fraction and flux as follows:
I In the Results toolbar, click .‘i 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Mole Fraction and Flux, H2in the
Label text field.

3 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.
Streamline |
I Right-click Mole Fraction and Flux, H2 and choose Streamline.

2 In the Settings window for Streamline, click Replace Expression in the upper-right corner
of the Expression section. From the menu, choose Component | (compl) >

Water Electrolyzer > Species H2 > we.tfluxH2x,...,we.tfluxH2z - Total flux.
3 Locate the Streamline Positioning section. In the Number text field, type 30.
4 Locate the Selection scction. From the Selection list, choose Outlet.

5 Locate the Coloring and Style section. Find the Point style subsection. From the Type list,
choose Arrow.

6 From the Arrow distribution list, choose Equal inverse time.

7 From the Color list, choose Gray.

Selection |

I Right-click Streamline | and choose Selection.

2 In the Settings window for Selection, locate the Selection section.
3 From the Selection list, choose Channel Domains.

Volume |
I In the Model Builder window, right-click Mole Fraction and Flux, H2 and choose Yolume.

26 | sSOLID OXIDE ELECTROLYZER



2 In the Settings window for Volume, click Replace Expression in the upper-right corner of
the Expression section. From the menu, choose Component | (compl) >
Water Electrolyzer > Species H2 > we.xH2 - Mole fraction - I.

3 Locate the Coloring and Style section. From the Color table list, choose ConopiformisZero.
Selection |

I Right-click Volume | and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Cathode.

4 Click the Show Grid button in the Graphics toolbar.

5 In the Mole Fraction and Flux, H2 toolbar, click Plot.

1_avg(10)=10000 A/m? Streamline: Total flux Volume: Mole fraction (1)

Cross-Sectional Electrolyte Current Density
Plot the current distribution across the electrolyte layer as follows:

I In the Results toolbar, click r. 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Cross-Sectional Electrolyte
Current Density in the Label text field.

3 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.
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Slice |
I Right-click Cross-Sectional Electrolyte Current Density and choose Slice.

2 In the Settings window for Slice, click Replace Expression in the upper-right corner of the
Expression section. From the menu, choose Component | (compl) > Water Electrolyzer >
Electrolyte current density vector - A/m* > we.llz - Electrolyte current density vector, z-

component.

Locate the Plane Data scction. From the Plane list, choose xy-planes.
From the Entry method list, choose Coordinates.

In the z-coordinates text field, type H_gde+H_el/2.

Locate the Coloring and Style section. From the Color table list, choose MetasepiaBlue.

N o0 i AW

In the Cross-Sectional Electrolyte Current Density toolbar, click Plot.

1_avg(10)=10000 A/m? Electrolyte current density vector, z-component (A/m?)
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Polarization Plot
Finally, add the Polarization Plot.

I In the Results toolbar, click .~ 1D Plot Group.

2 In the Settings window for ID Plot Group, type Polarization Plot in the Label text
field.

3 Click to expand the Title section. From the Title type list, choose Manual.
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4 In the Title text area, type Polarization plot.
5 Locate the Plot Settings section. Select the x-axis label checkbox.
6 Seclect the y-axis label checkbox.
7 In the x-axis label text field, type Average current density (A/cm<sup>2</sup>).
8 In the y-axis label text field, type Cell voltage (V).
Global | B
I In the Polarization Plot toolbar, click b:\ Global.
2 In the Settings window for Global, click Add Expression in the upper-right corner of the
y-Axis Data section. From the menu, choose Component | (compl) > Water Electrolyzer
> we.phis0_ecl - Electric potential on boundary - V.
3 Locate the x-Axis Data section. From the Parameter list, choose Expression.
4 In the Expression text field, type -aveop_an(we.nIs).
5 In the Unit field, type A/cm~2.
6 Click to expand the Legends section. Clear the Show legends checkbox.
7 In the Polarization Plot toolbar, click Plot.
Polarization plot
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Electrolyte Potential (we), Mole Fraction, H2, Streamline (we), Mole Fraction, H20,
Streamline (we)
I In the Model Builder window, under Results, Ctrl-click to select Electrolyte Potential (we),

Mole Fraction, H2, Streamline (we), and Mole Fraction, H20, Streamline (we).

2 Right-click and choose Delete.

Appendix - Geometry Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click [l 3D.

2 Click E,/ Done.

GLOBAL DEFINITIONS

Geometry Parameters

I In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometry Parameters in the Label text
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
soec_geom_parameters.txt.

GEOMETRY |

Anode
I In the Geometry toolbar, click |_'__'_|__'_':| Block.

In the Settings window for Block, type Anode in the Label text field.
Locate the Size and Shape section. In the Width text field, type W_cell.

2
3
4 In the Depth text field, type D_cell.
5 In the Height text field, type H_gde.
6

Locate the Selections of Resulting Entities section. Select the Resulting objects selection
checkbox.
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Electrolyte
I Right-click Anode and choose Duplicate.

2 In the Settings window for Block, type Electrolyte in the Label text field.
3 Locate the Pesition section. In the z text field, type H_gde.

Cathode

I Right-click Electrolyte and choose Duplicate.

2 In the Settings window for Block, type Cathode in the Label text field.

3 Locate the Position section. In the z text field, type H_gde+H_el.

Work Plane | (wpl)

I In the Geometry toolbar, click ﬁs Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition scction.
3 In the z-coordinate text field, type H_cell-H_ch.

Work Plane | (wpl) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane | (wpl) > Rectangle | (rl)

I In the Work Plane toolbar, click |:| Rectangle.
In the Settings window for Rectangle, locate the Size and Shape section.
In the Width text field, type W_ch.

2

3

4 In the Height text field, type N_ch* (W_ch+W_rib).

5 Locate the Position section. In the xw text field, type W_rib/2.
6

In the yw text field, type W_rib/2.

Work Plane | (wpl) > Rectangle 2 (r2)
I Right-click Component | (compl) > Geometry | > Work Plane | (wpl) > Plane Geometry

> Rectangle | (rl) and choose Duplicate.
2 In the Settings window for Rectangle, locate the Position section.
3 In the xw text field, type W_rib/2+L_ch+W_ch.
4 In the yw text field, type -W_rib/2.
Work Plane | (wpl) > Rectangle 3 (r3)
I In the Work Plane toolbar, click || Rectangle.
2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type L_ch.
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4 In the Height text field, type W_ch.
5 Locate the Position section. In the xw text field, type W_rib/2+W_ch.
6 In the yw text field, type W_rib/2.
Work Plane | (wpl) > Array | (arKrI),
I In the Work Plane toolbar, click /), Transforms and choose Array.
Select the object ¥3 only.
In the Settings window for Array, locate the Size section.

2

3

4 In the yw size text field, type N_ch.

5 Locate the Displacement section. In the yw text field, type W_ch+W_rib.
6

In the Work Plane toolbar, click [EE Build All.
Channel Domains
I In the Model Builder window, right-click Geometry 1 and choose Extrude.
2 In the Settings window for Extrude, type Channel Domains in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

Distances (m)

H_ch

4 Locate the Selections of Resulting Entities scction. Select the Resulting objects selection
checkbox.

Form Union (fin)
In the Model Builder window, right-click Form Union (fin) and choose Build Selected.

Inlet
I In the Geometry toolbar, click T Selections and choose Explicit Selection.
2 In the Settings window for Explicit Selection, type Inlet in the Label text field.

3 Locate the Entities to Select scction. From the Geometric entity level list, choose
Boundary.

4 On the object fin, select Boundary 19 only.

Outlet

I In the Geometry toolbar, click T Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Outlet in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose
Boundary.
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4

On the object fin, select Boundary 42 only.

Cathode Current Collector

|
2

4

In the Geometry toolbar, click g Selections and choose Explicit Selection.

In the Settings window for Explicit Selection, type Cathode Current Collector in the
Label text field.

Locate the Entities to Select section. From the Geometric entity level list, choose

Boundary.
On the object fin, select Boundaries 10, 26, 33, and 40 only.

Anode Current Collector

|
2

4

In the Geometry toolbar, click g Selections and choose Explicit Selection.

In the Settings window for Explicit Selection, type Anode Current Collector in the
Label text field.

Locate the Entities to Select section. From the Geometric entity level list, choose

Boundary.

On the object fin, select Boundary 3 only.

Channel Domain Boundaries

2
3
4
5
6

In the Geometry toolbar, click 5 Selections and choose Adjacent Selection.
In the Settings window for Adjacent Selection, locate the Input Entities section.
Click —+ Add.

In the Add dialog, sclect Channel Domains in the Input selections list.

Click OK.

In the Settings window for Adjacent Selection, type Channel Domain Boundaries in
the Label text field.

Boundary Layer Boundaries

|
2

N o i1 AW

In the Geometry toolbar, click " Selections and choose Difference Selection.

In the Settings window for Difference Selection, type Boundary Layer Boundaries in
the Label text ficld.

Locate the Geometric Entity Level section. From the Level list, choose Boundary.
Locate the Input Entities section. Click the - Add button for Selections to add.
In the Add dialog, select Channel Domain Boundaries in the Selections to add list.
Click OK.

In the Settings window for Difference Selection, locate the Input Entities section.
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8 Click the -+ Add button for Selections to subtract.
9 In the Add dialog, in the Selections to subtract list, choose Inlet and Outlet.
10 Click OK.
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